Ultra Mobile Guitar & Microphone 24-bit / 192 kHz USB
Audio Adapter
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ESI UGM192

1.4> 605923 >

UGM192 (F. 24 bit, 192 kHz/114 dB IAUF 1 DFH— /I JHB/NE USB-C A—F+ A
A>HF—TIT—ATY, ILFFEF— (Hi-ZAARDILAD MAKIRE) . FOTJzwvarl
BIAFZv o,/ A5 — A%, Mac/PC ¥ USB A —F 1 AMILE/ 1)L (R<¥— b
TARET LY M) ([TERTEEY. B/ (RIVICEIFTLABARFERR. Ay RR>(C
KBTI AN IOBEDRYTILEA LCANESEEZSIIUITEXYT., HEPRISATFSY—F
Oy atIILAR A UBREEITOBROBNRERMERDIEBTT. FI-—DPIIZHN
ety a>TE AYRKRUICKBIVIREBDUTIVIALEZFIIIERTEEY., &
MOHIBREIRETT, UGM192 (CFH—. AW RR>, Y. PC F@FE/NAILEBREIERITD
R THMERT T,

UGM192 (&, USB 3.1 TEMFI D USB-C /N X T, ZEMD USB 2.0 R (CEHELET.

1.1 e

UGM192 /\— RO T P DERHEEERFUTDRED TY,

1. HI-ZASAMIWAZRAAFYORIVL: T2INSOR 1/4"TS ikF. TLFFI—1RED
HBREERLET,

2. RAOVOATAZAAFvORIV 2: /)52 1/4"TRS #F. A4 FIvoOIAOF RG>
FIH—IAU%EHRUET ., 1/4"TRS - XLR ZEAFAHKRBELRIZE(E. UTOEERICECEE
W7 T —mERLTIEEN,
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XLREHF (R12)

1
o O

3
@)

Tip TRS iF (UGM192)
= ERe
Sleeve [ l | \

Sleeve Ring Tip
IRDBE. NS X /4" TRSIHF (DFEDRFLA") MBEERDFET,

3. AYRKRY/ SN : 7OINSORRAFLA 1/4"TRS FIOT T S aFILRARISH
AV RIRIAD, POFAITRISAEZS—, EZH-I>hO—-5—. SFH—5RE(CE
BUET,

4. USB-C OqYH—: 0> E1—4—DFE/\()LiEE & UGM192 Z#EH I DIHTF CTT. RMEIC
BT D 2 ADSENTNHD USB-C #FHor —TIL=EHERAL T, Mac, PC. E/\1)LiEE &
EHRUET. HEBREMFP(E. USB-CInFDER LED AT UET .

5. A0 USB ERANIHF : EBMOBREEAHRFTY. UGM192 (3/\X/XD—TEE TS
fzsh, BEGEREZEMTHIETDLESDEERA. Ny FTU—FaMPRNIAY—hITA>
EABRE, HEDBSCOHMEELRDHFTI. HATZIHEEF. /LNy FU—P
USB BHTERZANLTLIZE, PC/Mac TA—F « AESDRET /BEZEITIHE.
COmFIIEATETERA, BREHEE. USB-C/R— M BITo> T EEL,

A.  MONITOR RAYF : UFILAALANEZAVLIHEENDEXFT, R EZRI U
([C. 3TERDRENMIDEDDET,

1. /R&>% 1 BT E“MONO” LED BXT L. ARF v 2RIV 1 DIESHEF v RI)L. A
NFv2TIL 2 DESHEF v RIS EASNET,

2. MYz 2[ERY &“STEREOQ” LED AT U ANFr 2RIV 1L EANF 2RIV 2DE
Sz, EADW\WITNDOF v RIS EEZSY—TEFTY,

3. MRHZZE IERT &L EZHULINATCRD, LED PNVITNEEITLET, COE—
RlE. ABDFvoRIVEHDUEEA.
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MIC GAIN RAYF : XA TAAF V2RI 2 DAAT A 2= DBRFT.

1. /RF>%Z 1 EWI &, “+20 dB” LED AAXT L. AALANILA 20 dB ERUET .
2. MH>=2EHT &, “+30 dB” LED BT L. ABLANILA30dB ERULET,
3. MYz 3ERT & LED ANEIT U J+ SAREERNEBMICIRDE T,

+48 VI7 YA LBRAAYF : AT YA VFEAKORY 2RI E ANFrxR
U2 D+48 V T7 2SI LBRDAZ /ATHIDBEDDET, T7 25 LBRZEZAICTS
& “ON" LEDAITUET . ATICIT D& LED BSEITLET,

ER: D7 ALBRE. XA OZERUTHSAUICULTLIEEWN, XA TDERRICT 7> I
BRzEA>(CLRVWTLZEL,

R ONRBT—DILE. D72 A LEBREEATICUTHSEDHATLSICLTLIIREL,
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2.A42AM=)

2.1 RS AT

UGM192 BHERBTZHINA—FT A AA2H—TI—RATRBHDFEA, A—FTATDFT2VER
ECNEBFB/I\ALYFINARTY, CPU AFIIELHDFEFEBAN, BRI DS IXTLDMEED
UGM192 D/\T A4 =YD RICKEHFBLEY. TOLHEHO/N\—VYTExENZI>El—45—
DfEREHELEY.

BN AT LEMN
PC

- Windows 7 / 8/ 8.1/ 10 (32 XU 64-bit)
- 1 R¥DOUSB 2.0 £/2(F USB 3.1 R— b~ (91T AFFEHA1TC)

Mac

- 0S X/ mac0S 10.9 Mt
- 1RO USB 2.0 £/2(F USB 3.1 R— b~ (91T AFEREHATC)

2.2 )\— RO I P DI

UGM192 XT (&, O>Ea1—4—& USBR— NCEEERU CERLET. W35 A"Ee
DA C"DUSBR— hNTCOAED1—4F—&EBHRUET,. BRC(F. @Y1 TOr—JILh RS
NTWVWEY, UGM192 > Ea1—4—%#EHRITDRE. cnNSDOS350TNHhDsT—JILaFERL

TL &,
- ,_ ! ]

O>Ea1—#—DUSB “F1F A" R— A>Ea1—-5—DUSB &7 C" iR— b
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23 RSAN—&YIMITTDA A=)

UGM192 XT Z#0>Ea1—4— (I D& R/ \— RO 75/ X &L THBI BE(CIRE
ENFEY, LIZL. UGM192 DI NTOHEEZFER T DCERSA/\—DA A b—ILBBEELIRD
FY,

UGM192 > E1—4— Il 9 DEIC. www.esi-audio.com DM'SERHFDRSA/I\—&FT>
O—RIBCERBMSHERELET. RSA/N—FEA2AN=ILTBZET. UGM192 DI N TDHEEE
A Windows / OS X / macOS THIATEBRLDICIRDET,

BEVDITSOT—TUTOR—SICFIERTZET, PC Fzld Mac ADRH RSA/—/
YVIMIITFPEAFTEEY,

>>> http://en.esims/111 <<<

2.3.1 Windows AD1 > X R—JL

ZDETIE. UGM192 A RS /{—%& Windows 10 (CA> A h—ILIDHEEBHFLET .
Windows Vista. 7. 8. 8.1 ZHELDIFEE. BERNLRFIRFIELTY. RS1/—Z1>Xb—
JLFBAEIC. UGM192 20> Ea—~—([CHERELBVT RSV, EREHOBEF. T—TJILZR
DHLTHEA X M—IUEEZEITOTIIEEW,

AR M=)LZRETBIC(E. DT THA MSRIMRSA/N\—2Fo>0—-RU. RULET 7
LM S"setup.exe"ZEEILE T, 1> A M—S—ZEEH T B, Windows iAzFa1UFr DAY
T—2ERTRIDHENDDET. TOHEEF. 1A —ILOFAESZTIZEL. RIS, £F
[CRIFATOAINRRENET . “Next” Z0Uv0TDE. BFICRI I T7OITNRRSNE
ER

@ Setup - ESI UGM192 Driver - X @ Setup - ESIUGM192 Driver - X
Ready to Install
Welcome to the ESI UGM192 st . @
by - Setup is now ready to begin installing ESI UGM192 Driver on your computer.
Driver Setup Wizard ! ady to begin intalng ¥ ” C

This will install ES| UGM192 Driver version v1.0.0.0 on your Click Install to continue with the installation.
computer.

Itis recommended that you uninstall all previous versions of
the driver before continuing.

Click Next to continue, or Cancel to exit Setup.

Cancel <Back Tnstal Cancel

“Install” 20Uy O LET., T7IILOIE-NRAENET, LES<ITDEUTOSYr7OTN
RRENFI,
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Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Next.

Back Cancel

“Next” Z#7Uw I ULET, 5l&mEI7rILHATIE—aN. MTFD Windows EF+1UF« Avtz—

SHERENET .

=] Windows Security

GmbH".

device software is safe to install

[ Ahways trust software from "ES| Audiotechnik

@ You should only install driver software from publishers you trust. Ho

Would you like to install this device software?

Name: ESI Sound, video and game controllers
& ) Publisher: ESI Audictechnik GmbH

Install Den't Install

w can | decide which

“Install” 20Uy IULET, UES<TREA DA R—ILATT L. AT 7OINERRENE

ER

Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. i your device
came with instructions, please read them first

Driver Name Status
V/ESI (UGM192_AA) M. Readyto use
V/ES| (UGM192WDM.... Readyto use

Finish Cancel
]

@ Setup - ESIUGM192 Driver

Completing the EST UGM192
Driver Setup Wizard

To complete the installation of ESI UGM192 Driver, Setup
must restart your computer. Would you lie to restart now?

(@) Yes, restart the computer now

(ONo, I wil restart the computer later

EDDA 2 RONKRESNIZES. “Finish” #OUv2IUET . Z<DHE. BOSFAF7OINERRS
NFE9J. “Yes, restart the computer now"=:&R Ut “Finish” #0Uy 2O LT. I>E1—4—

ZHEH IS LB BBHLET,
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CNTRSAN—DA >R —)UEERTTUELRLE, UGM192 20> E1— 45— (LR TEET,
9D & Windows D EIEIEY (CHEERZIRE L. UGM192 HMERTEIRECRDET,

SRATFLBESR. 1 >AMIIORTTZER T DD, UTICTRIALZEO ESI 7K
RON\—DBHITY P ICRRSNTND N ZEZHR S0,

14:10

A e Q) B 20.11.2016

ZOTFAAHRTFENTONUE. RSAN—DA A M—ILAEYICE T LS ECRDET,

2.3.2 0S X/ macOS A\D1 > A =)L

0S X / macOS TUGM192 #FRATBIC(E. I> hO—ILRILY I RO 7RI THA b5
Ao O0—RUTLREEL, SHERADOS X / mac0S D/\—=3a > (CEHh5Y. FIBEEUTY,

Fo>0O-RUEdmg 7ML= TIVOUY OB E ITFDTA > ROD Finder (CRRENE
ED

® O = UGM192_Panel

A ‘
»

Applications UGM192

UGM192 O> bO—JU\RIEA A =L BICIE “PTUT—23>" TAINS—(CTOUv D
JRSYVIULET, A1>AM—ILEFTNTETTY,

UGM192 OEE /R #EAE(F UGM192 O hO—JL/KRILTHRELE TN, —ZOATS 3> (&,
Audio MIDIS&E (“7ZFUT—23>"/"A—F«UF«") TEEIDIRENSDFT.
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3. Windows > hO—JL/\2JL

AET(E. Windows iR UGM192 > bO—)L/KFILICDWTESR UE T . IR T)\—D@H T 77
[CRREND ESI PA O &S TIOVYOTRE. > bO-JURILERRSNES, O~
O—IL\RILZEEITDE. UTOREARRESNET,

® vomi2 — O X

File Config DirectWIRE Help

192

INPUT OUTPUT SAMPLERATE

oo
Lol 44,100 Hz

48,000 Hz

88,200 Mz

96.000 Hz

176,400 Mz

192,000 Hz

“File” AZ=1—®D"Always on Top” AT 3a>&=BMCITD &, MDY I NI 7ERPEI S
O—JLRILDA > RODWEICRIEICERRSN. “Windows Audio Settings” % Z DBEIEN SEEET
ZFEI, “Config” X =1 —0"Factory Defalts” Zi&RI D&, > bO—ILIRILERSA/I—-D
INSA—F—PFTAI)LMECUEY hENET . £z, “Help” > “About” (CT. RIED/(—
SIVEREERTEE T, DM RODAZT I —FECIE. FRMEEEPREEBNFTREINTULE
ER

INPUT

2 RROMBANF v 2 RILDES LN EZRRUET.
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OUTPUT

2 DOBEF v ORIUESORY 1 —AO> FO—ILRSAHF —ELNIA—ST —DNRRENET,
A—F—TEIC(F. HAZEZI1— FFTB"MUTE RG> ERXENF v > RILOBELN)UEN dB BfiI
TRRSNE T,

EAFr>FIDI T —F—DFEHEEYIATRSYIFTRE, MFv>RILDITT—45—%F
BFCO> hO—ILTEEXEYT (RFLA) » JI—F—REEBEREIDZET. @AROF v o RILLAR
LI hO—JLTEET,

SAMPLERATE

BIRhOY>I)ILL— MFRRENFE T, FEBRIVUYVIITRET, BT —hE2EBETSE
FY (A—F 4 AOBLE /BB LIZEEARA) . UGM192 (FFTSHINA—F 14 AA(>H—TT—RT
o INTDT TV —23>BIUPA—FT 1 AT —FE BUY>TILL— N T—HR(CULEBEINE
T, I\—RIT 7L 44.1 kHz~192 kHz (CHRAFT 1 TRIELTLET,

34 L1723 —8BLXVIN\Y T 7 —53E

3> hO—IWRILDOAZ 2 —H5"Config” > “Latency” Z#EIRFT B L. UGM192 RS /\—-DL
AF23— Ny I7—BAX"EERENFET) 2EEIDFI7OINRRENET . Ny
J7—HAXDEENEL<TBE LAFT2I—DEMNNELRDET, VI RDI TS EHo
H—OEREFRE, FAITDHBEICED TELAFT2S = OVy I7—hihaEn) BAHEF
IMBENRSBDFET., T, RELRLATUI—REQ. BEVDIRTLADOMREICEREKFLET.

SAFLAOEFEABWES (BRI ZF v RILBNOCT ST IASNEERE) F L1723 —
EREKUEADPRVNTLL S, LAF22— Ny I7—H1X(E BOTIETHRELEY. BT
EZUBBEMTHMDRZWMESR. A—FTAAT7TVT—23>DLAF2 2 —REBRZRET D&
BWTUL&D, BKOFPTUT—2 32 @@ SUBBNTLATOI—E2RRIDNSTI, Fz.

LAF2S—REDEER. AT AT7TVT—2 3 S RBFICTILENDDET.

A Za—"Config" > "USB Buffer"(CT. RSA/)\—HMERAT S USBF—HE&/\y IT7 -+ X%
BETETEI, BERFCOEZZEEITILEGFSHDFERA, ERELZODEFA-FT1ADLAFT>
S EREMRICETHEZSRDRD. - -—HNRETEBLSICLTVET . UL LNIE
TOLAF>2—fEY, CPU BERIIFOEEOE ENRDOESNDIHEEF. COREZEEIDIET
NIA RV RAZHEET D ENTEFY, USB Ny T 7 —DRBE/MES. BIFICERT MO
USB #881>. /> X h—JLEN TS USB O> bO—S— DR E, HRLABERTELLET .
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3.2 DirectWIRE &{RIEF v > 2RI

Windows T UGM192 %FR Y 3HA(d. ABNICKR2TZHIIA—FT 1 A NI —LDIL—TF
I\ JERENTE S DirectWIRE EWSHEERFIATEEYS., 7SI —2aETA—FT 1 AES
BILXR CTEDENHEETT, A—FAATTUT—2a>TIVIRIIOERELUED., A2
A>2DSATRET TV -3 (ESREITENTEET,

3R @ DirectWIRE (3. $FRIRBENCTOT v > 3 FILRRAREREL TESNIZIER(C/(D DL
IRHEETY . BADA—FT A AV I NI I P TEREDOREZITOIED. EaVA—FT« ADBLEZRLT
SIHEIRE. DirectWIRE ZRET DHEFEL<HDFE A,

BES 7O ERL(ICE. 3> bO—JLISRILD"DirectWIRE'"X —1 —D—BL(CH D
“Direct WIRE"Z#IRUFET . ULTFDI1 > RONFFRREINET .

@ DirectWwIRE X

INPUT WDM / MME
ouT IN
1
2
VIRTUAL 3
VIRTUAL &
VIRTUAL S
VIRTUAL &

MIX 3/4 12 MIX5/6T0 1/2

DirecrWRE

COIARITE BE (HH) FroRILEARF v oRIVERBT—-TILTEREI D ZENT
EEER

INPUT (D3/\— RO T 7 ANFv>xIL) . WDM/MME (Microsoft MME/WDM 1R% RS ){—
THFI AT A AVI NDITHESDBLE /HASICGANES) . ASIO (ADIO FERSA
IN—TEMFIDA—FTAAVIT RO THBOBE /MOBLIUVANES) B 3 DOFITHRREN
TWDDONHERTEET,

HOITICIE, EATERF v ORIV ENSTCEN> TUR MRRENTWVEY ., —H LT3R
FyoR)L 1 BXU 20 ZOTF(CARE (VIRTUAL) Fv >RILDRTH 3~6 DEECRRSNE
¥, CTICRRSNBZEME/MREF v > ILE. WINBEBIDORF LA WDM/MME F/{1 X &
LT, Windows 77U —2 3> h5R#eNEd, Fiz, ASIO WY I RO T 7 =ERTSD
& ASIO RSAN—EEATIVIERTBIELETEET,

DA ROTFEBDMIX 3/4 TO 1/2 "SEKUV'MIX 5/6 TO 1/2 "IRF>Z2BHCITD L REFv>
IV 3/4 (F12(E5/6) DIESHYEEN 1/2 (LY IRENET,
12
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MME/WDM S KU ASIO TL /Ny DiES(E, “OUT"ZIUYIFTBIETITa—~ (MIREHAD
KEEAT) TEFXT,

DirectWIRE {EFB#HI

Fr oRILEIDHTOREMNZBNLUEL &S, DirectWIRE DERFIGFZENTNIFIKIRT —XTH
D, BHERLY by T ICHIET ZHBORESERFEAEDDEFA, TTTRNI D,
DirectWIRE DJ/\D J)LIZHEEZ BN T 2H < FTHIICBEEEA.

@ DirectWIRE X

INPUT WDM / MME

1
2
VIRTUAL3
VIRTUAL 4
VIRTUALS
VIRTUAL &

MIX3/4T0 1/2 MIX 5/6 70 1/2

ka(aWﬁRE

LROFITIE, ASIO OUT 1 HKU ASIO OUT 2 i, WDM/MME VIRTUAL IN 3 & XU WDM/MME
VIRTUAL IN 4 [CHEHiENTUVET, SNIE ASIO 7TUS—23> (DAW RRE) OF v 2RIL
1/2 hSEADENZESH. WDM/MME WAVE T/ R 3/4 [CESNBDZ EEBKRUET. NI
&0 ASIO PTUT—2a>hSOENESE. ANFr>oRIL 3/4 TRE/TEITDENTEE
ED

Fiz, LRTEBEF V>RV 1/2 (WDM/MME OUT 1 &zl WDM/MME OUT 2) #¥ASIO A%
Fv 2RI 1/2 (ASIO IN 1 BEKU ASIO IN 2) [CHERESNTLWRZEB#RTEF Y. TNk
D. MME/WDMMIGY J RO T P OBEF v 2RI 1/2 DHN%ZEASIO 7T U -3 > (CAHL.
TBEPIOCYS 2 IIBTENTRECRDET. "OUTRIZHZ1— MMIBRESNTVD 8.
COESF UGM192 DYIEE AN S FHNENEEA.

®&(C. “MIX 3/4 TO 1/2"RF>EZBNCITDZET, REF v 2RI 3/4 hEDINRTOBEERE
S%& UGM192 DYIBE NN SEZSF—TEEXT,
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3.3 Windows A—5 1 ASRE

UGM192

Windows D*H> R hO—)L)CRILTA D2 & Tz(d EST O bO—)L) \RILD A Z 1 —"File”
> “Windows Audio Settings " Z#iR$ D L. “BE"BFIVEEFI 280" YU R"F17070

NERRENET,

 Sound

Playback  Recording Sounds = Communications

Select a playback device below to modify its settings:

 Sound

Playback Recording Sounds Communications

Select a recording device below to modify its settings:

[ concel |

Apply

Speakers UGM192
Q UGM192 Audio driver UGM192 Audio driver
@ Defaut Device Default Device
UGM192 VCH34 UGM192 VCH34
@ UGM192 Audio driver & UGM192 Audio driver
Ready Ready
UGM192 VCHS6 UGM192 VCHS6
.@ UGM192 Audio driver ,& UGM192 Audio driver
Ready Ready
v v
Configure Set Default |v Properties Configure Set Default }V Properties

S ==

Apply

“BE"IITDTINARURKCIE. AA>D MME / WDM A—F 4 AFT/I\A X THB"AE—H—"H
RRSNTVEY, THNE. HAF ORIV 1/2 [CHELFET ., MICE. REFv2RILTINART
% UGM192 VCH34 8K UGM192 VCH56 EHERTEF T,

SAFADEEZFPIIT T ST — AT TILAV-—REFENRTTUS -2 a>hB0E
ZUGM192 75N 3ICF. BHDT /A RAEBIRL., "REMCHE NRY 20UV ILET,

BRICHD> RO bO—ILIRILDBE "I TICE. AAZDANFTINA ANRRENTNE
Yo CNEYMBANDTF 2RIV SDESDFRS(CHERIDANF v 2RIV 1/2 (CHELFY. 2D
(S, ARIEF v >RILTINA R THD UGM192 VCH34 LU UGM192 VCH56 BHERTZF Y.

COUZRNCIE, OB —(CA AR —ILBHDINRTDA—FT 1 A)\— RO T FHERREN
F9., REDT/INARER/ELREWVES(F. COBAETEREIDIHENGDET. £e. FEAED
A—FaATTVT—2a3>(E FRTIT/NARAEERTEIRTEER LM/ TLNET.
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4. 0S X/ macOS > O—JLI\F)L

AEBETIE, Mac ik UGM192 O> bO—JL/INRILICDVWTHEFH LETI . OS X / macOS T,
UGM192 7O “TTUT—23>" TAINSI—(CA VA R=ILenFzd, COT7(I>%"5FT
WOV o9BE O hO—ILRILY T RO THEESL. U TFTOYA7OTNKRRENET.

O @ UGM192

192

OUTPUT SAMPLERATE

oo
- 44,100 Hz

48,000 Hz

88.200 Hz

96.000 Hz

176,400 Mz

“File” A=1—0 “Always on Top” AT 3a>&=BMCIDE. MOVI NI 7ERPEI> S
O—JLRILIA > RONE(CHIE(CRRESN. CDF7OTHS macOS DA—F 1 ARE(CFE
B(CT7OTRTEEY, “Config” XZ—1—0 “Factory Defaults” %##R9 3L, I> hO—JL/I (R
IWERSAN—DI\SA—F DB Y hEnNET ., £/, “Help” > “About” (CT. IRTE
DIN—=Z 3 VEREERBTETET . T2 RICIE. 2 DOERFREEBINFREINET,

OUTPUT

BEFvI>IL (2 26 ORU1—AO> FO-ILRASAHF —PRRENDEIZIZ T, A—
S—TEICIF. BHEZ1— FB"MUTE' RS> ZRRA. FEEJHRAF v >RILOBELAN)VED
dB B THRIRSNF T,

EAEFroRINITI—4F DT EEYIRATRSYI TR E, mFvoRILDIT T —5 —=E
[CO>bO-IILTEET (RFTLA) « BITT—H—REFRFIDZET. BEROF v RILLAR
JLEI> bO-LTEET,

SAMPLERATE

BERDOY > TILL — MIRRENFE T, FEBEIVUYITDIIET, Y2 TILL—hEEETE
FI (A—F 1 AOBE/BEFPEFEEARA) . UGM192 3T SHINA—FT A AA>H—-TT—RT

15
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Fo IRTDTTIT— 3> BREA—FT 1 AT —FE. BUY>TILL— hT—HR(ICULEBESNE
I, I\—ROTTE 44.1 kHz~192 kHz (CRA T« THIELTLET.

41 L1703 —BLUONY I 7—58E

Windows &E72D, 0S X / mac0S DL AF>>—(F, FHIZA-—FTAF7IUT—>3>

(DAW 712&) (CRIFUET ., Z<DFE. O bO—JILIRILTRRLKFIT VS —2 3 >ADA—
FTAAREEBmCHRELET, FHlE. BENDA—Fa AT TV -2 3> T =TSR
<TEELN,
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5. {Hi%

RmE / e

USB 3.1 A—F 1 A1 >4~ —Tx—R (USB-CifiF - Type-C &7 —TILIRE)

USB 2.0 Bift (USB Type-A to C&—JILHE)
USB /{X/ (D —BR&p
DirectWIRE HF v >R « IL—F« >335 (Windows)

DirectWIRE JL—2F)Cw Ji4sE (Windows)

*—F 1 Atk

24bit/192kHz AD J>/\—%—
ADCHAFZwoL > : 114dB(A-weighted)
THD+N -100dB (@ -1dBFS)
RAOTITTER
TRS/I\S>X 1/4x 1
48V IJ7 25 I
BRAAILANL : -8.6dBu
+10dB / +20dB &' > AT 3>
A2E—F >R 2.2kQ
Hi-Z 1> XA o)L A> BAAR
TST72NS2R 1/4%x 1
BAAHILAIL -8.4dBu
4> E—4 > : 500kQ
SA/NY RIRHD
TRS 1/4 AF L x 1
BAHHLAIL +6.4dBu (@ -0dBFS)
A2E—4F >R 32~600Q
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